Chapter 1
Visio 101

In This Chapter

Getting the scoop on Visio features
Understanding the lingo of Visio
Opening Visio and touring the screen
Getting help

Closing the program

0036 your eyes for a minute and picture the amount of visual information
that comes to you on any given day. Magazines, newspapers, reports,
television programs, and presentations illustrate a great deal of information
in the form of charts, tables, graphs, diagrams, and technical drawings. These
graphical elements often convey ideas far more quickly and clearly than long,
boring paragraphs. You don’t typically think of charts, diagrams, and graphs
as art, but they are graphical, and this is where Visio comes in.

Although Visio is easy to use, you can benefit from a bit of explanation before
you jump right in creating drawings. In this chapter, you become familiar with
what you see on the Visio screen and find out how Visio works conceptually.

Getting the Scoop on Uisio

In simple terms, Visio is a diagramming tool for anyone who needs to create
drawings, even self-confirmed nonartists. Although many people view Visio
as a drawing tool, it isn’t one, because it requires no artistic ability. It’s more
accurate to say that Visio is a diagramming tool. That’s reassuring because
even in highly analytical, non-art-related careers, you may need to create a
chart, diagram, or drawing! If the suggestion of drawing anything strikes
terror in your heart, Visio can help.
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Visio’s grab bag of icons — or shapes, as Visio calls them — represents all
sorts of things from computer network components, to office furniture, to
boxes on an organization chart or a flow chart, to electrical switches and
relays. Even programmers can use Visio to create diagrams that represent
application elements and then use that content to create the application. You
simply drag the shapes that you want into the drawing window, and arrange
and connect them the way that you want. You can add text and other graphi-
cal elements wherever you like.

Compatring Uisio products

Over the years, Visio has been available in several different flavors —
Standard, Professional, Technical, and Enterprise — plus you could find
advanced developer’s tools in Visual Studio .NET and advanced network dia-
gramming tools in Visio Enterprise Network Tools. Whew! All these versions
became confusing and overwhelming to the average user, so Microsoft
decided to simplify things and produce just two editions of Visio: Standard
and Professional. The same “engine” drives both, but the audience for each is
slightly different and the types of charts and diagrams you can create
address different needs:

v Visio Standard: Designed for business professionals, this edition gives
all kinds of businesspeople — from product managers to financial ana-
lysts to sales and marketing professionals — the ability to create busi-
ness-related charts and diagrams that illustrate business processes,
marketing trends, organizations, project schedules, and so on. However,
just about anyone can make use of this version. For example, an office
manager could use this version to show the office arrangement in a
building or the structure of an organization. It’s important to not limit
yourself; Visio can help you diagram just about anything you can imag-
ine as long as the diagram doesn’t require the precise measurements
normally provided by a computer-aided design (CAD) program.

v Visio Professional: Designed for technical users, this edition includes
everything that Visio Standard includes and more. Network managers
and designers, electrical engineers, [T managers, facilities planners,
Internet specialists, Web designers and administrators, and software
developers can use Visio Professional to create charts and diagrams that
illustrate a wide variety of technical concepts and processes. The pro-
fessional version also contains a number of database features that you
can use to import data from other applications. For example, you could
import information from Access and use it to create a special diagram.

So, how do you know which Visio is right for you? If you're involved in net-
works, IT, Internet or Web design, electrical engineering, architecture facili-
ties planning and management, or software development, Visio Professional
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is the edition to use because it provides all the shapes and symbols you need
to create simple or complex diagrams. If you're not involved in any of these
fields but are a business professional involved in company sales, profits, mar-
keting, or managing projects, Visio Standard is right for you. It includes all
the shapes you need to create business-related charts, diagrams, and draw-
ings, without cluttering your screen with shapes you’ll never use (such as a
proximity limit switch or a guided light transmitter).

It’s easy to get lost when you look at all of the diagrams that Visio can create.
Many people get started using Visio for simple needs. For example, just about
everyone needs a calendar from time to time. With Visio, you can create a
custom calendar to meet any need. You can also use it to create directional
maps to show someone how to get from the airport to your company. When
working with Visio, it’s best to start simple and work your way up to the com-
plex diagrams used by various professionals.

A quick peek at some Uisio features

Visio is often a misunderstood product, especially by those who’ve never
used it. Some people limit Visio to drawing organizational charts, but it can
do considerably more. The following list describes some of the tasks you can
perform with Visio:

v Printing what you want: Even though creating a diagram in Visio is
relatively easy, you still need to show other people the graphical repre-
sentation of your ideas. Fortunately, Visio provides extensive printing
capabilities, which means you get just the output you need. (See
Chapter 3 for more information on printing everything from a simple
calendar to complex floor diagrams.)

v Diagrams without drawing: Visio provides a wealth of shapes that you
can use to create diagrams of any type. All you do is place the shape
where you want to see it on-screen; no drawing is required! (See Chapter 2
for more information on using shapes to create any diagram type.)

v Customize shapes easily: One of the best features of Visio is that you
can use it to customize shapes in a number of ways. You can add text,
modify the size of the shape, change its appearance, and connect
shapes. No matter what your skill level or how you use Visio, you can
create professional-looking results with a few clicks. (See Chapters 5
through 7 for details on customizing shapes simply. Chapter 8 describes
how you can create your own shapes when the defaults don’t work.
Chapters 9 through 12 show how to manipulate shapes in various ways.)

1 See only the data you need: Data overload is a condition where you
become overwhelmed by the very data that you're supposed to use to
complete tasks. Layering in Visio helps you reduce complexity by letting
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you see only the layer of data you actually need. All of the data is still
there, but you only access it when you actually need it. (See Chapter 10
for ideas on how you can use layering to manage your data efficiently.)

1 Make your diagrams a group activity: The ability to comment on ideas in
a group is essential in business today. The diagrams that you create are
ideas only they’re in graphical, rather than textual, format. Visio helps you
make the diagrams you create a group activity by providing a number of
ways to add comments and revisions. (See Chapter 13 for more informa-
tion on working with comments and the Visio review features.)

+” Report on data: Wouldn't it be great if you could store data in a drawing
and then report on that data? With Visio, you can. Suppose you draw an
office layout plan that includes cubicle walls, fixtures, office furniture,
and telephone and computer equipment. You can store each piece of fur-
niture and office equipment with data such as its inventory number,
owner, and current location. From this drawing, you can generate prop-
erty, inventory, and location reports. (See Chapter 12 for more informa-
tion on storing and reporting on data in shapes.)

v Use the drill-down feature: Jump quickly from an overview drawing to a
detailed drawing and back again. For example, you can draw an overview
map of a worldwide computer network and double-click the name of a
city to see a drawing of that city’s computer network. This drill-down fea-
ture is possible because Visio lets you define a shape’s behavior when
you double-click it. (See Chapter 12 for more information.)

* Generate drawings from data: In contrast to the previous point, would-
n’t it be great to be able to generate drawings from existing data? Again,
with Visio, you can. Suppose you have employee data (name, title,
department, reporting manager, and so on) stored in a text or spread-
sheet file. You can generate an organization chart automatically from
this data using Visio. (See Chapter 14 for more information on using
external data in Visio.)

v Use hyperlinks: Often, you can’t convey in a single drawing all the infor-
mation necessary to make your point. You might want to refer the reader
to a separate drawing, a Web site, or another document with related
information. With Visio, you can add hyperlinks to a drawing or shape.
This is an invaluable feature for pulling pieces of information together to
present a comprehensive picture. (See Chapter 14 for tips on using
hyperlinks in diagrams.)

Visio actually provides support for eight categories of drawings. You can
create everything from business charts to software and database diagrams.
The “Understanding the Visio Drawing Categories” section of Chapter 2 pro-
vides a description of each of these drawing categories so that you have a
better idea of precisely what Visio can do for you.
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What’s new in Uisio 2007?

Visio 2007 has a lot to offer. With each update, Visio improves the functional-
ity you need to create diagrams quickly. The emphasis in this update is
efficiency — helping you get more done with fewer errors and in less time.
The following list provides you with an overview of the major feature
changes in Visio 2007. You'll see these features described in more detail
throughout the book.

v~ Starting quickly with improved templates: Visio 2007 supports fewer
template categories and the category names now make more sense. You
actually have access to more templates, but Microsoft has organized
them better. In addition, the template examples are larger with clear text
descriptions, so you have a better idea of how to use a particular tem-
plate. A recent template list tells you which templates you use most
often and makes these templates easier to access. The Professional edi-
tion also includes sample diagrams and data sources that you can use
as examples of how to retrieve data from your own data sources.

v Improving drawing appearance with themes: You have probably seen
the effect of themes in Windows. A theme in Visio is the same concept.
You use themes to give your diagrams a particular appearance. Using
themes helps ensure that your diagrams have a pleasing appearance and
are easy to see.

1 Automatically connecting shapes: Visio now makes it easier to create
great-looking drawings with greater ease by creating the connections
you need automatically and aligning new drawing elements. You can
connect drawing elements when you drag the shape onto the form.
However, when you decide to make the connection later, all you need to
do is point at the two connectors that you want to connect. You'll dis-
cover more about these fast connection techniques in Chapter 6.

v Sharing diagrams with other Office applications: Keeping others
informed about your ideas is essential. This feature relies on SharePoint
server to make it easier to share data in various ways. For example, you
can generate a Visio pivotdiagram from within Microsoft Project and place
it on SharePoint server for comment by other collaborators. You can also
attach Visio diagrams to e-mail created in Outlook. Other people can see
the diagrams even if they don’t have Visio installed.

v~ Saving data using the XPS file format: A problem with custom data for-
mats is that it isn’t easy to move the data to other locations. The XML
Paper Specification (XPS) file format provides a standard method of
saving your data in a form that other applications can use. You can effec-
tively use the data in any application that supports XML.

13
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v Improving efficiency with smaller diagrams: Other people don’t always
need every piece of information in a diagram. For example, you might
have unused master shapes or comments that other people don’t need
to see. Visio makes it easier to clean up your diagrams before you send
them to someone else. In addition to presenting a cleaner form, your dia-
gram will also consume less space, making it more efficient for data
transfers and local storage.

One of the ways you can determine whether you need Visio Professional edi-
tion is by the features it provides. The following list describes a number of
special features that the Professional edition provides. These aren’t the only
differences, but they’re significant reasons for choosing the Professional edi-
tion over the Standard edition.

1 New templates and shapes: The Professional edition of Visio comes with
a number of new templates and shapes that make it easier to display
complex data on-screen. The PivotDiagram, Value Stream Map, and
Information Technology Infrastructure Library (ITIL) templates help you
model complex data in new ways. In addition, the new Work Flow shapes
that are part of the Work Flow Diagram template help you model dynamic
workflows that better match how people in your company perform tasks.
Workflows model business processes of all types, which includes every-
thing from the steps to produce a product to the events that occur when
you receive a customer order.

v Using data from other sources in diagrams: You already have a vast
store of data to use in creating diagrams. The problem is that this data
isn’t in graphical format, making it very difficult to understand. Visio
now makes it easy to create a connection to that data so that the infor-
mation you already have appears in the diagrams you create. Because of
the connection between your diagram and the data source, any changes
in the data automatically appear in the diagram. A new Data Selector
Wizard helps you create the data connection to data in other applica-
tions such as Access, SQL Server, and Excel (in addition to a number of
non-Microsoft products).

1 Seeing data in the Data Graphics task pane: Getting data from an exter-
nal data source is only part of the process. Although plain text is fine for
a report, you might want to dress it up a bit for your diagram. The Data
Graphics task pane helps you turn plain text into something that will
dazzle those around you.

1 Viewing complex data using a pivotdiagram: A pivotdiagram is a collec-
tion of shapes in a treelike structure that helps you present complex
data in a less confusing manner. Using a pivotdiagram helps you analyze
the data, drill down into it, and display it from various perspectives.
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Familiarizing Yourself with Uisio Lingo

Like all software programs, Visio uses a particular terminology. You need to
be familiar with the following terms before you begin creating diagrams and
drawings:

v+ Drag and drop: The method Visio uses to create drawings. What are you
dragging and where are you dropping it, you ask? You drag shapes and
you drop them onto a drawing page.

v~ Shape: Probably the most important element in Visio. A shape repre-
sents an object of nearly any conceivable kind, such as a piece of office
furniture in an office-layout diagram, a road sign in a directional map, a
server in a network diagram, a box on an organization chart, or a bar on
a comparison chart. Visio contains literally thousands of shapes. You
can draw and save your own shapes as described in Chapter 8.

v Master shape: A shape that you see on a stencil. When you drag a shape
onto the drawing page, you're copying a master shape onto your drawing
page, making it just one instance of that shape. Visio makes the distinc-
tion between master shapes and instances of shapes. The only time this
distinction is important is when you begin modifying Visio to meet spe-
cific needs by creating your own shapes.

v Stencil: A tool Visio uses to organize shapes so that you can find the one
you're looking for. A stencil is nothing more than a collection of related
shapes. If you want to create a cubicle-layout diagram for your office, for
example, you use the cubicles stencil, which includes shapes such as
workstations, posts, panels, work surfaces, storage units, and file cabi-
nets. Stencils are displayed in the Shapes pane on the left side of the
screen so that the shapes are always available while you’re working.

1 Template: A collection of stencils in addition to predefined document
settings. A template is essentially a model for creating a particular type
of drawing. A template defines certain characteristics of the drawing so
that the drawing is consistent. For example, when you use a Visio tem-
plate for a specific type of drawing, Visio automatically opens one or
more appropriate stencils, defines the page size and scale of your draw-
ing, and defines appropriate styles for things such as text, fills, and lines.
You can change any of these elements, but the point of using a template
is to maintain consistency throughout the drawing.

+ Connector: A line that connects one shape to another. Perhaps the most
common example of a connector is in an organization chart. The lines that
connect the president to various groups in an organization and the lines
that run through an organization are connectors. Chapter 6 describes con-
nectors in detail.

15
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Understanding the Uista Difference

Visio operates a little differently from a visual and security perspective under
Vista than it does under earlier versions of Windows, such as Windows XP. In
fact, you don’t get to see all of the functionality that Visio can provide unless
you use it under Vista. The best way to describe these differences is to group
them into two categories: graphical (what you can see) and security (the pro-
tection Visio provides).

In addition to Visio-specific changes, Vista also requires a change in how you
perform some Visio-related tasks. For example, when you want to work with a
printer in Vista, you must locate it within the Control Panel. It’s easy to find
the Vista specifics in the Visio help file. Simply type Vista in the Search field
of the Visio Help file and click Search. The following sections describe the
Visio-specific differences in Vista.

The graphical interface difference

Vista sports the new Aero Glass visual interface. This new interface offers
some efficiencies not found in older versions of Windows and, of course, it
provides a healthy dose of eye candy. The big thing to remember is that Vista
doesn’t affect the actual functionality of Visio. All of the features (the tech-
niques you use to perform a task) work the same under Windows XP as they
do under Vista.

You do receive some additional benefits from using Vista. Graphics do appear
faster on-screen and you’ll notice that Vista does tend to make the graphics
look better. For example, the fonts are easier to read and the lines used to
create a diagram look crisper. Even though this might seem like a small bene-
fit for Visio users who work in Vista, the effects can reduce eyestrain and
help you avoid mistakes that you might otherwise make. Vista makes it less
likely that you’ll encounter errors such as connections where you didn’t
think any existed.

Helpful user interface changes

Vista also promises to be a less painful experience for users. For example,
normally when you apply a patch and the system has to reboot, you have to
restart your applications, locate your position, and only then start work
again. It’s a waste of time and effort. Vista provides a new feature called
Freeze Dry that remembers program settings such as window size, window
position, and even cursor position. After a system reboots, Vista automati-
cally resets your Office application to its previous state for you.
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You may have run into problems accessing information on international Web
sites in the past. Vista now supports the special characters used by these Web
sites so that your Visio experience can include data from these sites. In addi-
tion, Vista provides full Internet Protocol Version 6 (IPv6) support. This means
that your copy of Visio is ready to work with the additional Web addresses
that IPv6 provides.

All Office products now use the Vista Save, Open, and Insert common dialog
boxes, which means that you gain full access to the Vista functionality. The
Vista functionality includes the ability to organize your files with greater ease
and to search for documents based on metadata as well as regular content.
For example, you can search for a Visio document based on the author or the
comments you provide.

A very useful feature for Visio users is the ability to store a thumbnail of your
diagram. Instead of looking one document at a time for a particular diagram,
you can simply view the thumbnails. This feature makes it considerably
easier to locate a particular diagram. Even when several diagrams look simi-
lar, you can usually reduce the number of diagrams you have to check.

Office also emphasizes reliability under Vista. If Office or Vista detects that a
certain operation could cause the operating system to crash, Office will stop
the operation and tell you about the problem, rather than attempting to per-
form the operation as it did in the past. Generally, this feature means that
you’ll not only see fewer crashes, but you'll also encounter a reduced risk of
data loss.

Understanding the security features

The biggest reason to use Vista is the security features. It’s a lot easier to pro-
tect the data in your diagrams under Vista and you'll find that the security is
very reliable. In addition, many of the security features work automatically.
You don’t have to remember to change a setting to protect the data, in many
cases, because Vista does it for you — at least from an operating system
level. The following sections describe a few other security changes for Visio
users under Vista.

Defining the difference between users and administrators

One of the most difficult changes that users will encounter under Vista is that
it differentiates between users and administrators. In addition, every account
works in user mode most of the time. Consequently, activities that might
have worked fine in the past may not work under Vista. For example, you’ll
find that you need to give yourself permission to access your data directory.
Although this sounds very odd, it does help protect your data. No one gains
access to your data unless you specifically give him rights to do so.

17
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Digitally signing your macros

You’ll probably find that those macros you relied on in previous versions of
Visio no longer work. That’s because most people don’t sign their macros. In
order to use macros successfully in many cases, you must digitally sign the
file that contains them. Since Microsoft is making this particular feature more
robust as it introduces new versions of Office and Windows, it’s probably a
good time to start signing your macros now.

In addition to macros, you'll find that Vista makes it more difficult to perform
some tasks using Explorer or typing from the command line. For example,
you must have administrative privileges to perform tasks such as deleting a
file. These changes work along with the macro protection to make it less
likely that an errant macro will destroy your data. If your macro performs any
command line tasks, such as deleting a file, it also requires the correct privi-
leges. The bottom line is that no matter how you try to perform some tasks,
Vista won’t let you unless you have the correct rights. Many macros will
simply stop working as currently written.

This book doesn’t discuss how to create or use macros. A book such as VBA
For Dummies, 5th Edition (published by Wiley) provides complete coverage
of this topic.

Relying on trusted locations

Vista is also quite fussy about where you store your data. Trying to open a
file on a network drive or store data on a network drive will normally meet
with a number of permission requests. Generally, you must have administra-
tive privileges or specific rights on the network drive to use it. In this case,
however, you can get around the problem by setting Visio to use trusted loca-
tions. See the “Saving Drawings” section of Chapter 2 for more details on
using trusted locations.

Jumping Head First into Uisio

The best way to get started with Visio is to open a new drawing page, so you
can cruise around the screen and get a feel for what’s there. Then, in Chapter 2,
you create a drawing.

To start Visio, choose Start=>Programs=>Microsoft Officec>Microsoft Office
Visio 2007. Visio displays the window shown in Figure 1-1.
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Visio divides the application functionality into several areas. At the top are
the toolbars and menus you use when working with Visio. Most of the toolbar
entries are grayed out because you haven’t selected a template yet. The rest
of the book describes these entries. Along the left side of the display, you see
several entries that control the appearance of the right side of Visio. For
example, when you select Getting Started, you see topics that help you begin
using Visio. The following list describes these entries:

1 Getting Started: This entry displays two panes. The center pane con-
tains information on how to get started using Visio. You can obtain infor-
mation about training, templates, and downloading, in addition to the
latest news about Visio. The right pane contains a list of your current
projects. Simply click the project to open it.

v Samples: If you're wondering how to use a particular diagram template
or simply don’t want to start from scratch, select the Samples entry.
This entry also displays two panes on the right side. The center pane
contains a list of the samples that Microsoft has provided. The sample
entry contains a basic view of the template type and the sample name.
The right pane contains a detailed view of the selected sample. The dia-
gram is bigger and more detailed. You'll also see a write-up about the
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Figure 1-2:

A typical
drawing
screenin
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sample. To use the sample, select the US Units or Metric option, and
click Open Sample Data.

v Category: The Category list shows eight items. These items represent
the diagram types including Business, Engineering, Flowchart, General,
Maps and Floor Plans, Network, Schedule, and Software and Database.
Selecting a particular category displays a list of associated templates in
the center pane. For example, when you select the Business category,
you see Brainstorming Diagram, Organizational Chart, and PivotDiagram
as templates. Below these templates is a list of other templates that you
might want to see when looking for business diagrams, even though
Microsoft hasn’t placed them in this category. Select a particular tem-
plate and you'll see a larger, more detailed picture of it along with a two-
or three-sentence description. To create a new drawing based on a tem-
plate, choose the template, select the US Units or Metric option, and
click Create.

Getting familiar with the Uisio screen

A typical Visio screen looks like the one shown in Figure 1-2. This screen is
displayed when you select the General category and the Basic Diagram (US
units) template. In this section, you look at what’s going on in this window.
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The display contains the same menu, Standard toolbar, and Formatting tool-
bar as before, but the entries are active now. The left side of the display con-
tains the Shapes window, while the right side contains the Drawing window.

The Shapes window contains the list of shapes that you can use. In this case,
the drawing is using the Box shape. The shapes appear within stencils. This
example uses the Blocks (US Units) stencil.

The Drawing window contains the area where you create a diagram. You see
rulers across the top and left side of this window that help you position and
size shapes. The drawing area looks like graph paper. You can use the lines to
position shapes, as shown in Figure 1-2.

Checking out the menus

Visio’s menu bar contains some typical menus found in almost every Windows
application (such as File, Edit, Format, and Help). Even so, it’s important to
review each menu for commands that you may not expect. The following list
describes commands unique to Visio (even though some of the menus might
look familiar):

v Tools: On this menu, you find all kinds of tools for working with Visio
shapes, the Visio drawing page, and the drawing itself. There are tools
for setting Visio’s color palette, rulers, grids, and so on. You also find the
standard Microsoft options such as Spelling, Track Markup, Customize,
and Options.

v Data: The Data menu only appears when you use the Professional edi-
tion. It contains entries that help you obtain data from other sources
and create reports.

v Shape: The Shape menu contains commands for grouping, rotating, flip-
ping, and aligning, as well as commands for choosing a drawing’s color
scheme. You also find commands for changing the stacking order of
shapes and doing some creative things such as fragmenting and inter-
secting shapes. (See Chapter 8 for details.)

The options on the Shape menu change depending on the type of draw-
ing you're creating.

For certain types of drawings, Visio adds an additional menu to the menu bar.
For example, when you create a Gantt chart using the Gantt Chart template in
the Schedule category, Visio adds a Gantt Chart menu just after the Shape
menu and before the Window menu (see Figure 1-3). On the Gantt Chart
menu, you find commands specific to creating Gantt charts, such as adding
and deleting tasks, linking tasks, and setting working hours. As soon as you
close the drawing, the menu option disappears.

21
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Figure 1-3:
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Figure 1-4:
The toolbar
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Working with toolbars

Visio has a dozen or so toolbars, two of which are displayed automatically
when you start the program. The two default toolbars are Standard and
Formatting. You can hide either of these, and you can display additional tool-
bars as well.

After you begin to recognize the toolbar buttons, it’s much faster to click a
button than to select a menu command. Many of these buttons appear on the
Cheat Sheet at the beginning of this book.

To hide or display toolbars, right-click anywhere in the toolbar area. On the
shortcut menu that appears, click a toolbar name. Toolbars that have a check
mark next to them are displayed; all others are hidden (see Figure 1-4).
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Figure 1-5:
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Creating a toolbar
To create a custom toolbar, follow these steps:

All Visio toolbars can be docked at different locations on the screen. Just grab
the vertical bar at the left end of any toolbar and drag it to a new location on
the screen. A moved toolbar automatically becomes its own window, and you
can position it anywhere you like on the screen by dragging its title bar.

If you're a toolbar fanatic, you might want to customize the toolbars by adding
buttons you use most often and deleting buttons you never use. You can also
choose any buttons you want and create a new toolbar.

1. Choose View=>Toolbars-~>Customize.

Visio displays the Customize dialog box.

2. On the Toolbars tab, click the New button.

Visio displays the New Toolbar dialog box.

3. In the Toolbar Name field, type a name (see Figure 1-5), and then click

the OK button.

Visio adds the new name to the list of toolbars and displays a new, blank
toolbar on the screen. (It’s small, but it’s there!)

Toolbars | Commands | Options

Toolbars:

v EETET N - | | e

| Formatting
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|| Data
Developer
Drawing
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|| Format Text
Ink

|| Layout & Routing

E Reset...

Attach...

7] Merus Bar
Picture
Reviewing

L Toobar name:

[ Snap &ciuf oo

["] stenal Custom 1
Task Pane

Cancel

Close

4. If you want to add buttons to the new toolbar, drag and drop the new
blank toolbar into the toolbar area, and then follow the steps in the
next section, “Modifying a toolbar.”

5. Click Close to close the Customize dialog box.
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|
Figure 1-6:
Choose a
toolbar on
the left and
buttons on
the right.

Modifying a toolbar

If you just want to add a button here or there, consider modifying an existing
toolbar rather than creating a new one. However, in many cases, it’s a good
idea to create your own custom toolbar so that you can see everything you
want without having to worry about someone changing the toolbar back to a
default state later. Use the following steps to modify any toolbar:

1. Display the toolbar that you want to change.

To do so, right-click the toolbar area and select the toolbar.

2. Right-click the toolbar and choose Customize.

Visio displays the Customize dialog box.

3. Click the Commands tab.

Categories are on the left and commands are on the right, as shown in

Figure 1-6.

| Toolbars | Commands | Options |

To add a command to & toolbar: select a category and drag the command out

of this dizlog box to a toolbar.

Categories: Commands:
. i
=4 _] MewDrawing
View || | ] Mew Drawing (Metric)
Insert
Format Text _] Mew Drawing {US Units)
Eun_nat Shape O mew

oS
Data Getting Started...
Shape Operations e . _
Drawing Tools = | | | New Drawing from Template...

78] =

Rearrange Commands. ..

Close

4. Click a category on the left, and then scroll through the list of com-
mands (buttons) on the right.

5. Drag the button from the dialog box to the location on the toolbar
where you want to add the button.

When you release the mouse button, the new button becomes part of
the existing toolbar at the point where you dropped it.

Deleting a button from a toolbar

Sometimes you end up with buttons you don’t really want on a toolbar. The
following steps tell how to remove a button from a toolbar:

1. Display the toolbar that you want to change.
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2. Right-click the toolbar and choose Customize.
Visio displays the Customize dialog box.

3. Drag the button that you want to delete off the toolbar.
If you want to delete additional buttons, repeat this step.

4. Click the Close button to close the Customize dialog box.

Getting Help When You Need It

|
Figure 1-7:
The general
help topics
help you
find the
information
you need
quickly.
|

Visio makes it easy to obtain help about any topic. Microsoft has centralized
help in Visio 2007 and made it easier to use. The following sections describe
the two forms of help that Visio provides.

Using general help

Visio presents help using a separate window. You can display this window by
clicking the question mark (?) in any dialog box and pointing to any control.
Visio displays the Help window with the information for that control displayed.
If you want help on a general topic, choose the Helpr=>Microsoft Office Visio
Help command. You see a general listing of Visio help as shown in Figure 1-7.

O ) b AT LU & :

> |~ Search -
ﬁﬂhdm » =
g Whats new -
“J/At_ti'-'ati'lg Visio Professional .
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Browse Visio
@@ security and privacy
@ Working in a different language ‘What's new Activating Visio Professional
L4 File management Getting help Security and privacy
& Saving and printing
.;Cuslun{.ng Working in & different language File management
~
.;f/Macms Saving and printing Customizing i
- EE Macros Drawing
.wFo’mahir:g
& Inserting Formatting Insarting
@ Ins
& Setting up pages Setting up pages Using data in drawings
&plsng data in drawings Business diagrams Flowchart diagrams
.wEu:ines: diagrams
& Flowchart diagrams General diagrams Maps and fioor plans
@ Flowdchart
& General diagrams Network and Web site diagrams Schedule diagrams
gz Maps and fi lans
qpioes onc or paos Software and database model diagrams ‘Working with other people —
& MNetwork and Web site diagrams
\.4/S<Ju:d_||=: dagrams Working with other programs

“ Software and database model diagrams

@ Viorking with other people About This Template
.w\'fnming with other programs Gantt ::hart (US L[njtS)

(@ More information sbout this temolate

& Connected to Office On



26

Part I: Starting with Visio 2007 Basics

\\3

If you don’t see the help you want, type a search term in the Type Words to
Search For field and click Search. For example, if you want to learn more
about the Vista differences for Visio, type Vista and click Search. Help dis-
plays all of the entries associated with Vista in the right pane.

Sometimes Help returns too much information. You can limit the scope of a
search by clicking the down arrow next to the Search button. The context
menu contains a list of places that you can search. For example, you might
choose to search just the Visio Templates, rather than All Visio (the default).

You may not have any search terms in mind when you begin your search.
Perhaps you’re just looking to see what Visio offers. In this case, you can use
the Table of Contents list in the left pane of the Help window. Click a book
icon to open that particular topic. You can drill down through the topics to
find the information you need.

Don’t forget ToolTips

Like most Windows programs, Visio also uses ToolTips. When you point to a
button on a toolbar and hover over it (pause without clicking), a tip pops up
to tell you the name of the button. This is especially helpful when you're
learning Visio.

Visio expanded the concept of ToolTips to its stencils. When you hover over
a stencil shape, a tip pops up and gives the name of the shape and a descrip-
tion, as shown in Figure 1-8.

If you don’t want to view ToolTips or stencil tips, choose Tools=>Options, and
then click the View tab. Click to remove the check mark from Toolbar
ScreenTips and Other ScreenTips, and then click OK.
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Closing Ulisio

When you're ready to close Visio, choose Filer>Exit. If you haven’t recently
saved all open files, Visio prompts you to do so for each file. Choose Yes to
save or Cancel to return to Visio without saving the drawing.
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